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RZ/T1 グループ 
EtherCAT サンプルプログラムの実装ガイド 
(R-IN Engine 搭載製品) 

要旨 

本アプリケーションノートでは、PLCから産業用 ACサーボなどを制御する場合に利用される EtherCAT®

通信における EtherCATスレーブを RZ/T1 グループで実現するためのサンプルプログラムについて説明しま

す。 

サンプルプログラムの特徴を以下に示します。 

 サンプルプログラムは Cortex®-R4 コアと Cortex®-M3コアで動作します。Cortex-M3は EtherCAT 通

信を担当、Cortex-R4は EtherCATマスターへの送信データの生成、受信データの LED表示などを担

当します。CPU間通信には共有メモリドライバを使用します。 

 EtherCAT 通信プログラムは Beckhoff 社製 EtherCATスレーブサンプルコード生成ツール（SSC 

Tool）で作成します。SSC Toolのプロジェクトファイル、ESIファイル及び RZ/T1 ハードウェア依存

部など本サンプルプログラム向けの修正を行うためのパッチファイルを提供します。 

 サンプルプログラムは(1)32 ビット入出力の簡易 I/Oコントローラ・サンプル（以後 I/O コントロー

ラ・サンプル）、(2)CiA402 ドライブプロファイル動作確認用サンプル（以後 CiA402サンプル）の 2

種類です。 

 

対象デバイス 

RZ/T1 グループ(R-INエンジン搭載製品) 
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1. 仕様 

表 1.1使用する周辺機能と用途を、図 1.1 に動作環境を示します。 

表 1.1使用する周辺機能と用途 

周辺機能 用途 

クロック発生回路 CPU クロックおよび低速オンチップオシレータで使用 

EtherCAT スレーブ・コントローラ EtherCAT 通信で使用 

イーサネット MAC(ETHERC) EtherCAT 通信で使用 

割り込みコントローラ（ICUA） EtherCATSlave割り込み（EtherCAT、EtherCAT Sync0）、

コンペアマッチ割り込み（CMI0、CMI1）で使用 

コンペアマッチタイマ（CMT） コンペアマッチタイマの周期カウント動作で使用 

拡張内蔵 RAM 共用メモリ領域（Data RAM）および Cortex-M3用 

プログラム領域メモリ（Instruction RAM）で使用 

エラーコントロールモジュール（ECM） ERROROUT#端子の初期化 

汎用入出力ポート LED表示、キー入力のための端子制御に使用 

 

 

図 1.1 動作環境 

注)EtherCAT マスターとの接続は LANインタフェース J1（EtherCAT1ポート）をご使用ください。 
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2. 動作環境 

本アプリケーションノートのサンプルプログラムは、下記の環境を想定しています。 

表 2.1動作環境 

項目 内容 

使用ボード RZ/T1 評価ボード 

RTK7910022C00000BR 

CPU RZ/T1 (R-IN エンジン内蔵版) 

R7S910017 

動作周波数 CPUクロック (CPUCLK)：450MHz (Cortex-R4) 

システムクロック (ICLK)：150MHz (Cortex-M3) 

動作電圧 3.3V 

動作モード 16 ビットバスブートモード 

SPIブートモード 

使用デバイス ・NOR フラッシュメモリ 

Macronix 製 MX29GL512FLT2I-10Q 

・シリアルフラッシュメモリ 

Macronix 製 MX25L51245GMI-10G 

・EEPROM 

ルネサスエレクトロニクス 製 R1EX24016ASAS0 

・Ethernet PHY 

Micrel 製 KSZ8041TL 

通信プロトコル EtherCAT® 

統合開発環境 IARシステムズ 製 

Embedded Workbench® for Arm Version 8.20.2 

エミュレータ IARシステムズ 製 

I-jet 

SSC Tool EtherCAT Technology Group (ETG) 提供 

Slave Stack Code (SSC) Tool Version 5.12 

ソフトウェア PLC Beckhoff Automation 製 

TwinCAT® 3 
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3. 周辺機能説明 

クロック発生回路、EtherCAT スレーブ・コントローラ、イーサネット MAC(ETHERC)、割り込みコントロー

ラ（ICUA）、コンペアマッチタイマ（CMT）、エラーコントロールモジュール（ECM）、拡張内蔵 RAM、汎用

入出力ポートについての基本的な内容は、RZ/T1 グループ・ユーザーズマニュアル  ハードウェア編を参照

してください。 
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4. ハードウェア説明 

4.1 ハードウェア構成例 

図 4.1に I/Oコントローラ・サンプル、図 4.2に CiA402 サンプルのハードウェア構成例を示します。 

 
図 4.1 ハードウェア構成例(I/Oコントローラ・サンプル) 

 

  

LED3 LED0 LED1 LED2 

EEPROM (16k bit) 

MII:8 
ch0 

PF7 P56 P77 PA0 

CMT Ch0 I/O Port 

ICUA 
（Interrupt Control Unit A） Cortex-R4 

RZ/T1 

レジスタライト 
プロテクション機能 

消費電力低減機能 

イーサネット
MAC(ETHERC) 

CMT Ch1 

Coretex-M3 拡張内蔵 RAM 

PHY PHY 

MII:8 
ch1 

EtherCAT スレーブ 
コントローラ 

EtherCAT LED 

CATI2C CATLED 
CATLINKAC
 



RZ/T1 グループ   EtherCAT サンプルプログラムの実装ガイド(R-IN Engine 搭載製品) 

R01AN3071JJ0110  Rev.1.10  Page 7 of 28 
2018.8.31  

 
図 4.2 ハードウェア構成例(CiA402サンプル) 
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4.2 使用端子一覧 

表 4.1 使用端子と機能を示します。 

表 4.1 使用端子と機能 

端子名 入出力 内容 

MD0 入力 動作モードの選択 

MD0=”L”、MD1=”L”、MD2=”L” （SPIブートモード） 

MD0=”L”、MD1=”H”、MD2=”L” （16ビットバスブートモード） 

MD1 入力 

MD2 入力 

ETH_MDIO 入出力 マネージメント・データ信号入出力 

ETH_MDC 出力 マネージメント・インタフェース・クロック出力 

ETH0_RXC 入出力 受信クロック入出力 

ETH1_RXC 

ETH0_RXER 入力 受信データ・エラー信号入力 

ETH1_RXER 

ETH0_RXDV 入力 受信データ・イネーブル信号入力 

ETH1_RXDV 

ETH0_RXD0~3 入力 受信データ信号入力 

ETH1_RXD0~3 

ETH0_TXC 入力 10 M／100 M 送信クロック（2.5 MHz / 25 MHz）入力 

ETH1_TXC 

ETH0_TXER 出力 送信エラー信号出力 

ETH1_TXER 

ETH0_TXEN 出力 送信イネーブル信号出力 

ETH1_TXEN 

ETH0_TXD0~3 出力 送信データ信号出力 

ETH1_TXD0~3 

ETH0_COL 入力 衝突検出信号入力 

ETH1_COL 

ETH0_CRS 入力 キャリアセンス信号入力 

ETH1_CRS 

CLKOUT25M0 出力 Ethernet PHY用の外部クロック出力 

CLKOUT25M1 

PHYRESETOUT# 出力 PHY RESETOUT出力 

PHYLINK0 入力 PHY Link 信号（Ether Switch 用）入力 

PHYLINK1 

ETHSWSECOUT 出力 Ether Switchの 1 秒毎のイベント出力 

ETH0_INT 入力 Ethernet PHY割り込み要求信号入力 
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ETH1_INT 

CATI2CCLK 出力 EtherCAT EEPROM I2C クロック信号出力 

CATI2CDATA 入出力 EtherCAT EEPROM I2C データ信号入出力 

CATLINKACT1 出力 EtherCAT Link／Activity LED信号出力 

CATLINKACT0 

CATLEDRUN 出力 EtherCAT RUN LED信号出力 

CATLEDSTER 出力 EtherCAT Dual-color ステート LED 信号 

CATLEDERR 出力 EtherCAT Error LED信号出力 

PF7 出力 LED0の点灯および消灯 

P56 出力 LED1の点灯および消灯 

P77 出力 LED2の点灯および消灯 

PA0 出力 LED3の点灯および消灯 

P35 入力 SW1の入力 
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5. ソフトウェア説明 

5.1 ソフトウェア構成 

図 5.1にサンプルプログラムのソフトウェア構成図を示します。 

 
Note 1. Renesas provides the EtherCAT SSC projects that has reflected the hardware-dependent 

processing and necessary modifications. 
Note 2. SSC Tool: EtherCAT control program generation tool provided by Beckhoff 

図 5.1 ソフトウェア構成図 

 

5.2 ディレクトリ構成 

5.2.1 Cortex-M3サンプルプログラム 

\workspace\iccarm\Cortex-M3\を Cortex-M3サンプルプログラムを格納するカレントディレクトリとします。 

ディレクトリ 内容 

../CMSIS Cortex-M3関連定義（CMSIS をそ

のまま使用）格納ディレクトリ 

../Device/Renesas/RIN_Engine/Include インクルード・ファイル格納ディ

レクトリ 

../Device/Renesas/RIN_Engine/Library ライブラリ格納ディレクトリ 

../Device/Renesas/RIN_Engine/Source/Board ボード依存ソースファイル格納

ディレクトリ 

../Device/Renesas/RIN_Engine/Source/Driver ペリフェラル・ドライバ・ソース

ファイル格納ディレクトリ 

../Device/Renesas/RIN_Engine/Source/Project_Dual/EtherCAT_

SSC_DC+hwos 

I/Oコントローラ・サンプルプロ

ジェクト格納ディレクトリ 

../Device/Renesas/RIN_Engine/Source/Project_Dual/EtherCAT_

SSC_CiA402+hwos 

CiA402 サンプル・プロジェクト

格納ディレクトリ 

../Device/Renesas/RIN_Engine/Source/Templates スタートアップ・ファイル格納

ディレクトリ 

表 5.1 Cortex-M3サンプルプログラムのディレクトリ構成 
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5.2.2 Cortex-R4サンプルプログラム 

\workspace\iccarm\Cortex-R4を Cortex-R4サンプルプログラムを格納するカレントディレクトリとします。 

ディレクトリ 内容 

../ EtherCAT_SSC_DC I/Oコントローラ・サンプルプロ

ジェクト格納ディレクトリ 

../ EtherCAT_SSC_CiA402 CiA402 サンプル・プロジェクト

格納ディレクトリ 

 

5.3 動作概要 

5.3.1 I/Oコントローラ・サンプル 

図 5.2に I/Oコントローラ・サンプルの電源投入~EtherCAT 通信開始までの概略フローチャートを示しま

す。 

 

Cortex-R4 コア側のプログラムは、電源投入後に初期設定を行い Cortex-M3 コアのプログラムコードを

外付けフラッシュメモリから拡張内蔵 RAM へコピーし、Cortex-M3 コアのリセット解除を行います。その

後 LED 制御用のポート設定や CMT0及び CMT1の初期化、周期イベント、割り込みの設定を行います。 

 

Cortex-M3コア側のプログラムは、リセット解除後に初期設定を行い HW-RTOSセットアップにより各タス

ク生成後、main_taskを起動します。main_taskでは、EtherCATプロトコルスタックの初期設定等を行い、

sub_task を起動します。 

 

図 5.3に EtherCAT 通信開始後の概略フローチャートを示します。 

 

Cortex-R4 コア側は、CMT0周期イベントで共有メモリの Outputカウンターの値をリードし、下位 4bitの

値を LED3-0 に出力します。また、CMT1周期イベントで Input カウンターをインクリメントして値を共有メ

モリにコピーします。 

 

Cortex-M3コア側は、sub_taskで EtherCAT プロトコルスタックのメイン処理を実行します。EtherCAT割

り込み及び EtherCAT Sync0 割り込み処理内では、EtherCAT マスターからの 32bit Output の値を共有メモ

リの Output カウンターにコピーするとともに共有メモリの Inputカウンターの値をリードし、32bit Input

として EtherCATマスターに送信します。 



RZ/T1 グループ   EtherCAT サンプルプログラムの実装ガイド(R-IN Engine 搭載製品) 

R01AN3071JJ0110  Rev.1.10  Page 12 of 28 
2018.8.31  

 

図 5.2 I/O コントローラ・サンプル概略フローチャート 1 
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図 5.3 I/O コントローラ・サンプル概略フローチャート 2 
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5.3.2 CiA402サンプル 

図 5.4に CiA402 サンプルの概略フローチャートを示します。 

 

Cortex-R4 コア側のプログラムは、電源投入後に初期設定を行い Cortex-M3 コアのプログラムコードを

外付けフラッシュメモリから拡張内蔵 RAM へコピーし、Cortex-M3 コアのリセット解除を行います。その

後 LED 制御用のポート設定や CMT0の初期化、周期イベント、割り込みの設定を行います。 

メインループでは、Cortex-M3からの CPU間割り込みが発生したかをチェック、発生した場合は共有メモ

リにアクセスして TargetPositionの値をリード、ActualPositionの値をコピーします。また、SW1の入力

と LED1の出力を行います。 

 

CMT0周期イベントでは、疑似モータ制御処理として SW1 が押下されている間、TargetPosition の値と等

しくなるまで ActualPosition の値をインクリメントします。 

 

Cortex-M3コア側のプログラムは、リセット解除後に初期設定を行い HW-RTOSセットアップにより各タス

ク生成後、main_taskを起動します。main_taskでは、EtherCATプロトコルスタックや CiA402ドライブプ

ロファイルの初期設定等を行い、EtherCAT プロトコルスタックを実行します。 

EtherCAT 割り込み及び EtherCAT Sync0 割り込み処理内では、CiA402 の状態遷移を実行するとともに、共

有メモリから ActualPosition の値をリードし、TargetPosition の値をライトします。また、Cortex-R4コ

アに対し CPU間割り込みを発生させます。 
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図 5.4 CiA402 サンプル概略フローチャート 
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Cortex-R4 Cortex-M3

共有メモリ

（拡張内蔵RAMD)

CiA402ドライブプロファイル初期設定

EtherCATプロトコルスタック

メイン処理
MainLoop()

EtherCAT 割り込み処理
PDI_Isr()

EtherCAT Sync0 割り込み処理
Sync0_Isr()

共有メモリドライバ初期化
R_SHM_Init()

CPU間割り込み

あり？

共有メモリアクセス

TargetPosition

PositionActualValue

TargetVelocity

VelocityActualValue

CPU間割り込み発生

疑似モータ制御処理
DummyMotor()
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6. サンプルプログラムの作成手順 

サンプルプログラムを作成する手順を示します。 

サンプルプログラムを作成するには EtherCAT Slave Stack Code Tool(SSCツール)が必要です。 

注)SSCツールは Ver5.12を使用してください。 

6.1 I/Oコントローラ・サンプル 

（1） Windowsスタートメニューより SSC ツールを起動します 

(EtherCAT Slave Stack Code Tool ⇒ SSC Tool) 

（2） 新規プロジェクトを作成します ([File] ⇒ [New]) 

（3） [Import]を押し、I/Oコントローラ・サンプル向けの SSCツール コンフィギュレーションファイル

を選択します 

\workspace\iccarm\Cortex-M3\Device\Renesas\RIN_Engine\Source\Project_Dual 

\EtherCAT_SSC_DC+hwos\RenesasSDK\CONFIG\Renesase_RZT1 config.xml 

コンフィギュレーションファイルが読み込まれると以下のようになります 

 

 
図 6.1 SSC ツール・コンフィグレーションファイルのインポート 

一度読み込むと以降は Custom に登録されドロップダウンより選択可能となります。 

（4）  [OK]を押し、メッセージに従いハードウェア処理ファイル(renesashw.c)を読み込みます 

\workspace\iccarm\Cortex-M3\Device\Renesas\RIN_Engine\Source\Project_Dual 

\EtherCAT_SSC_DC+hwos\RenesasSDK\renesashw.c 

（5） [Project] ⇒ [Create new Slave Files] を選択 

（6） Start を押し、EtherCAT Slave Stack Code 生成します 

（7） [New files created successfully]が表示されると生成完了です 

\workspace\iccarm\Cortex-M3\Device\Renesas\RIN_Engine\Source\Project_Dual 

\EtherCAT_SSC_DC+hwos\RenesasSDK\Src  
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6.2 CiA402 サンプル 
（1） サンプルプログラムの SSCプロジェクトファイルをダブルクリックし、SSCツールを起動します 

\workspace\iccarm\Cortex-M3\Device\Renesas\RIN_Engine\Source\Project_Dual 

\EtherCAT_SSC_CiA402+hwos\RenesasSDK\ssc_project\RZT1-R EtherCAT demo CiA402.esp 

 

 
図 6.2 SSC ツール CiA402 サンプル 

 

（2） [Project] ⇒ [Create new Slave Files] を選択 

（3） Start を押し、EtherCAT Slave Stack Code 生成します 

（4） [New files created successfully]が表示されると生成完了です。 

\workspace\iccarm\Cortex-M3\Device\Renesas\RIN_Engine\Source\Project_Dual 

\EtherCAT_SSC_CiA402+hwos\RenesasSDK\ssc_project\Src 

（5） パッチコマンドをインストールしていない場合 

GNU Patch Ver2.5.9以後が必要です。 

下記の Webサイトからパッチコマンド(Ver2.5.9)をダウンロードし”patch.exe”をディレクトリパ

スの通ったフォルダに格納します。 

http://gnuwin32.sourceforge.net/packages/patch.htm 
 

（6） パッチの適用 

apply_patch.batファイルを右クリックして[管理者として実行] ⇒ [はい]を選択します。 

パッチファイルは SSC ソースファイルに対する RZ/T1向けの修正を含んでいます。 

\workspace\iccarm\Cortex-M3\Device\Renesas\RIN_Engine\Source\Project_Dual 

\EtherCAT_SSC_CiA402+hwos\RenesasSDK\apply_patch.bat(バッチファイル) 

\workspace\iccarm\Cortex-M3\Device\Renesas\RIN_Engine\Source\Project_Dual 

\EtherCAT_SSC_CiA402+hwos\RenesasSDK\SSC_CiA402_yyyymmdd.patch(パッチファイル) 

(yyyymmdd:パッチファイル作成日) 
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図 6.3 パッチコマンド実行画面 

パッチ実行後、修正されたソースファイルは下記のフォルダに格納されます。 

\workspace\iccarm\Cortex-M3\Device\Renesas\RIN_Engine\Source\Project_Dual 

\EtherCAT_SSC_CiA402+hwos\RenesasSDK\Src 
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7. TwinCAT接続時の設定方法 

TwinCAT3 を使用してサンプルプログラムを操作する方法について説明します。 

先に作成したサンプルプログラムのソースコードをビルドし、プログラムを起動させてください。 

7.1 ESIファイルのコピー 

TwinCATを起動する前にサンプルプログラムに含まれている ESIファイルを TwinCATの所定の場所

(\TwinCAT\3.x\Config\IO\EtherCAT)にコピーしてください。 

 I/Oコントローラ・サンプルの場合 

\workspace\iccarm\Cortex-M3\Device\Renesas\RIN_Engine\Source\Project_Dual 

\EtherCAT_SSC_DC+hwos\RenesasSDK\ESI_File\RZT1-R EtherCATdemo[DC].xml 

 CiA402 サンプルの場合 

\workspace\iccarm\Cortex-M3\Device\Renesas\RIN_Engine\Source\Project_Dual 

\EtherCAT_SSC_CiA402+hwos\RenesasSDK\ ESI_File\RZT1-R EtherCAT CiA402.xml 

 

7.2 TwinCATとの接続 

下記の方法でTwinCAT3を起動してください。 

 

■ スタートメニューから、[Beckhoff] ⇒[TwinCAT3] ⇒ [TwinCAT XAE (VS20XX)]を選択 

プログラム起動後、[File] ⇒ [New] ⇒ [Project] として、TwinCAT XAE Projectタイプの新規プロジェ

クトを作成してください。以降の手順を以下に記載します。 

7.2.1 ESIファイルのリロード設定 

TwinCAT側から追加したサンプルプログラムの ESIファイルの読み取りを行ってください。 

 

 
図 7.1 ESI ファイルリロード 

上記の[Reload Device Descriptions]を選択してください。 

  



RZ/T1 グループ   EtherCAT サンプルプログラムの実装ガイド(R-IN Engine 搭載製品) 

R01AN3071JJ0110  Rev.1.10  Page 20 of 28 
2018.8.31  

7.2.2 I/O デバイスのスキャン 
 

 
 

図 7.2 I/O デバイスのスキャン 

 

上記の[I/O Device]を選択し、右クリックしますと 別ウインドウが開きます。この別ウインドウの

[Scan]を選択し、実行します。Scan 実行後に表示されるウインドウの設定については図 7.3、図 7.4に

従って選択してください。 

 

 
 

 

図 7.3 I/O デバイスのスキャン設定 1 

 



RZ/T1 グループ   EtherCAT サンプルプログラムの実装ガイド(R-IN Engine 搭載製品) 

R01AN3071JJ0110  Rev.1.10  Page 21 of 28 
2018.8.31  

 

 

 
図 7.4 I/O デバイスのスキャン設定 2 

  

このウインドウは CiA402 サンプルの 

場合に表示されます 
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7.2.3 EEPROMデータ更新 

既に別のアプリケーションのデータが書き込まれている場合は EEPROMの書き換えを行ってください。 

以下に EEPROMの書き換えを行う際の手順を記載します。 

 

[1] “Box 1”をダブルクリックすると、右側に図 7.5 のようなパネルが表示されます。 

[2] “EtherCAT”タブを選択 

[3] “Advanced Setting”のボタンをクリックしてください。 

[4] [ESC Access] ⇒ [EEPROM] ⇒ [Hex Editor]としてください。 

[5] “Download from list”を選択してください。 

[6] “Available EEPROM Description”を選択してください。 

 I/Oコントローラ・サンプルの場合 

[Renesas Electronics Corp.] ⇒ [RZ/T1-R Slaves] ⇒ [RZ/T1-R EtherCAT Demo[DC]] 

 CiA402 サンプルの場合 

[Renesas Electronics Corp.] ⇒ [RZ/T1-R Slaves] ⇒ [RZ/T1-R EtherCAT CiA402] 

[7] “OK”のボタンをクリックしてください。 

書き換え後は RZ/T1を再起動し（電源再投入またはリセット）、書き換えたデータがマイコンの 

動作に反映されるようにしてください。 

 

[8] “Restart TwinCAT System” を行ってください 
 

 

 
 

図 7.5 EEPROM 書き換え手順 1 
  

[1] 

[2] 

[3] 

[5] 

[4] 
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図 7.6 EEPROM 書き換え手順 2 
 

7.2.4 通信ステータスの確認 

“Online”タブを選択し、ステータスが”OP”に遷移していることを確認します。 

 
図 7.7 通信ステータス確認 

注)OP モードに遷移しない場合は、”Activate Configuration”、”Restart TwinCAT(Config Mode)”等

の操作をお試しください。 

[6] 

[7] 

[8] 
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7.3 データ送受信 

7.3.1 I/Oコントローラ・サンプル 

（1） 32Bit Input の確認 

[32Bit Input] ⇒ [Online]を選択します。 

値が更新（インクリメント）されるのが確認できます。 

 
 

図 7.8 32bit Input 値の確認 

（2） 32Bit Outputの設定 

[32Bit Output] ⇒ [Online] ⇒ [Write]を選択します。 

[Set Value Dialog]に値を設定して“OK”のボタンをクリックしてください。 

設定値の下位 4 ビットが LED3-0に表示されます。(bit=1 のとき LED点灯) 

 
 

図 7.9 32bit Output 値の設定 

 

インクリメント 



RZ/T1 グループ   EtherCAT サンプルプログラムの実装ガイド(R-IN Engine 搭載製品) 

R01AN3071JJ0110  Rev.1.10  Page 25 of 28 
2018.8.31  

7.3.2 CiA402 サンプル 

（1） CiA402 状態遷移 

[Control Word]の値を「7」→「15」と順に設定し、[Status Word]が「0x1237」”Operation Enabled ”

になることを確認してください。 

 

 

図 7.10 CiA402状態遷移 

注)CiA402の状態遷移につきましては CiA402 規格書をご参照ください。 
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（2） 疑似モータ操作 

[Target Position]に目標値となる任意の値を設定します。 

次に SW1 を押して[Actual Position]の値を変化させます。SW1を押下している間、[Actual Position]の

値は[Target Position] に設定した値と等しい値になるまでインクリメントされます。SW１が OFFになると

[Actual Position]の値は「0」になります。 

また、SW１を押下している間、LED1 が点灯します。 

 

 

 
 

図 7.11 疑似モータ操作 
  

インクリメント 
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8. サンプルプログラム 

サンプルプログラムは、ルネサスエレクトロニクスホームページから入手してください。 

 

9. 参考ドキュメント 

 ユーザーズマニュアル：ハードウェア 

RZ/T1 グループ ユーザーズマニュアル ハードウェア編  

（最新版をルネサスエレクトロニクスホームページから入手してください。） 

 

RZ/T1 評価ボード RTK7910022C00000BRユーザーズマニュアル  

（最新版をルネサスエレクトロニクスホームページから入手してください。） 

 

 ドキュメント／アプリケーションノート／サンプルコード 

RZ/T1 グループ 初期設定 

（最新版をルネサスエレクトロニクスホームページから入手してください。） 

 

RZ/T1 グループ コンペアマッチタイマ(CMT) 

（最新版をルネサスエレクトロニクスホームページから入手してください。） 

 

RZ/T1 グループ EtherCAT通信手順(R-IN Engine 搭載製品) 

（最新版をルネサスエレクトロニクスホームページから入手してください。） 

 

 テクニカルアップデート／テクニカルニュース 

（最新の情報をルネサスエレクトロニクスホームページから入手してください。） 

 

 ユーザーズマニュアル：開発環境 

IAR統合開発環境（IAR Embedded Workbench® for Arm）に関しては、IAR ホームページから入手 

してください。 
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10. ホームページとサポート窓口 

ルネサスエレクトロニクスホームページ 
http://japan.renesas.com/ 

 
お問合せ先 

http://japan.renesas.com/contact/ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
すべての商標および登録商標は，それぞれの所有者に帰属します。

http://japan.renesas.com/
http://japan.renesas.com/contact/
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製品ご使用上の注意事項 
ここでは、マイコン製品全体に適用する「使用上の注意事項」について説明します。個別の使用上の注意

事項については、本ドキュメントおよびテクニカルアップデートを参照してください。 
 

1. 未使用端子の処理 
【注意】未使用端子は、本文の「未使用端子の処理」に従って処理してください。 
CMOS製品の入力端子のインピーダンスは、一般に、ハイインピーダンスとなっています。未使用 
端子を開放状態で動作させると、誘導現象により、LSI周辺のノイズが印加され、LSI内部で貫通電 
流が流れたり、入力信号と認識されて誤動作を起こす恐れがあります。未使用端子は、本文「未使

用端子の処理」で説明する指示に従い処理してください。 
2. 電源投入時の処置 

【注意】電源投入時は，製品の状態は不定です。 
電源投入時には、LSIの内部回路の状態は不確定であり、レジスタの設定や各端子の状態は不定で 
す。 
外部リセット端子でリセットする製品の場合、電源投入からリセットが有効になるまでの期間、端

子の状態は保証できません。 
同様に、内蔵パワーオンリセット機能を使用してリセットする製品の場合、電源投入からリセット

のかかる一定電圧に達するまでの期間、端子の状態は保証できません。 
3. リザーブアドレス（予約領域）のアクセス禁止 

【注意】リザーブアドレス（予約領域）のアクセスを禁止します。 
アドレス領域には、将来の機能拡張用に割り付けられているリザーブアドレス（予約領域）があり

ます。これらのアドレスをアクセスしたときの動作については、保証できませんので、アクセスし

ないようにしてください。 
4. クロックについて 

【注意】リセット時は、クロックが安定した後、リセットを解除してください。 
プログラム実行中のクロック切り替え時は、切り替え先クロックが安定した後に切り替えてくださ

い。 
リセット時、外部発振子（または外部発振回路）を用いたクロックで動作を開始するシステムで

は、クロックが十分安定した後、リセットを解除してください。また、プログラムの途中で外部発

振子 
（または外部発振回路）を用いたクロックに切り替える場合は、切り替え先のクロックが十分安定

してから切り替えてください。 
5. 製品間の相違について 

【注意】型名の異なる製品に変更する場合は、製品型名ごとにシステム評価試験を実施してくださ 
い。 
同じグループのマイコンでも型名が違うと、内部ROM、レイアウトパターンの相違などにより、電 
気的特性の範囲で、特性値、動作マージン、ノイズ耐量、ノイズ輻射量などが異なる場合がありま 
す。型名が違う製品に変更する場合は、個々の製品ごとにシステム評価試験を実施してください。 
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■営業お問合せ窓口

■技術的なお問合せおよび資料のご請求は下記へどうぞ。
　総合お問合せ窓口：https://www.renesas.com/contact/

ルネサス エレクトロニクス株式会社　〒135-0061　東京都江東区豊洲3-2-24（豊洲フォレシア）

© 2018  Renesas Electronics Corporation. All rights reserved.
Colophon 6.0

http://www.renesas.com
※営業お問合せ窓口の住所は変更になることがあります。最新情報につきましては、弊社ホームページをご覧ください。

ご注意書き

1. 本資料に記載された回路、ソフトウェアおよびこれらに関連する情報は、半導体製品の動作例、応用例を説明するものです。お客様の機器・システムの設計におい

て、回路、ソフトウェアおよびこれらに関連する情報を使用する場合には、お客様の責任において行ってください。これらの使用に起因して生じた損害（お客様

または第三者いずれに生じた損害も含みます。以下同じです。）に関し、当社は、一切その責任を負いません。

2. 当社製品、本資料に記載された製品デ－タ、図、表、プログラム、アルゴリズム、応用回路例等の情報の使用に起因して発生した第三者の特許権、著作権その他の

知的財産権に対する侵害またはこれらに関する紛争について、当社は、何らの保証を行うものではなく、また責任を負うものではありません。

3. 当社は、本資料に基づき当社または第三者の特許権、著作権その他の知的財産権を何ら許諾するものではありません。

4. 当社製品を、全部または一部を問わず、改造、改変、複製、リバースエンジニアリング、その他、不適切に使用しないでください。かかる改造、改変、複製、リ

バースエンジニアリング等により生じた損害に関し、当社は、一切その責任を負いません。

5. 当社は、当社製品の品質水準を「標準水準」および「高品質水準」に分類しており、各品質水準は、以下に示す用途に製品が使用されることを意図しております。

標準水準： コンピュータ、OA機器、通信機器、計測機器、AV機器、

家電、工作機械、パーソナル機器、産業用ロボット等

高品質水準： 輸送機器（自動車、電車、船舶等）、交通制御（信号）、大規模通信機器、

金融端末基幹システム、各種安全制御装置等

当社製品は、データシート等により高信頼性、Harsh environment向け製品と定義しているものを除き、直接生命・身体に危害を及ぼす可能性のある機器・システ

ム（生命維持装置、人体に埋め込み使用するもの等）、もしくは多大な物的損害を発生させるおそれのある機器・システム（宇宙機器と、海底中継器、原子力制

御システム、航空機制御システム、プラント基幹システム、軍事機器等）に使用されることを意図しておらず、これらの用途に使用することは想定していませ

ん。たとえ、当社が想定していない用途に当社製品を使用したことにより損害が生じても、当社は一切その責任を負いません。

6. 当社製品をご使用の際は、最新の製品情報（データシート、ユーザーズマニュアル、アプリケーションノート、信頼性ハンドブックに記載の「半導体デバイスの使

用上の一般的な注意事項」等）をご確認の上、当社が指定する最大定格、動作電源電圧範囲、放熱特性、実装条件その他指定条件の範囲内でご使用ください。指

定条件の範囲を超えて当社製品をご使用された場合の故障、誤動作の不具合および事故につきましては、当社は、一切その責任を負いません。

7. 当社は、当社製品の品質および信頼性の向上に努めていますが、半導体製品はある確率で故障が発生したり、使用条件によっては誤動作したりする場合がありま

す。また、当社製品は、データシート等において高信頼性、Harsh environment向け製品と定義しているものを除き、耐放射線設計を行っておりません。仮に当社

製品の故障または誤動作が生じた場合であっても、人身事故、火災事故その他社会的損害等を生じさせないよう、お客様の責任において、冗長設計、延焼対策設

計、誤動作防止設計等の安全設計およびエージング処理等、お客様の機器・システムとしての出荷保証を行ってください。特に、マイコンソフトウェアは、単独

での検証は困難なため、お客様の機器・システムとしての安全検証をお客様の責任で行ってください。

8. 当社製品の環境適合性等の詳細につきましては、製品個別に必ず当社営業窓口までお問合せください。ご使用に際しては、特定の物質の含有・使用を規制するRoHS

指令等、適用される環境関連法令を十分調査のうえ、かかる法令に適合するようご使用ください。かかる法令を遵守しないことにより生じた損害に関して、当社

は、一切その責任を負いません。

9. 当社製品および技術を国内外の法令および規則により製造・使用・販売を禁止されている機器・システムに使用することはできません。当社製品および技術を輸

出、販売または移転等する場合は、「外国為替及び外国貿易法」その他日本国および適用される外国の輸出管理関連法規を遵守し、それらの定めるところに従い

必要な手続きを行ってください。

10. お客様が当社製品を第三者に転売等される場合には、事前に当該第三者に対して、本ご注意書き記載の諸条件を通知する責任を負うものといたします。

11. 本資料の全部または一部を当社の文書による事前の承諾を得ることなく転載または複製することを禁じます。

12. 本資料に記載されている内容または当社製品についてご不明な点がございましたら、当社の営業担当者までお問合せください。

注1. 本資料において使用されている「当社」とは、ルネサス エレクトロニクス株式会社およびルネサス エレクトロニクス株式会社が直接的、間接的に支配する会

社をいいます。

注2. 本資料において使用されている「当社製品」とは、注1において定義された当社の開発、製造製品をいいます。

(Rev.4.0-1  2017.11)
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